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Experiment 3   

Modeling Conformations, ChemDraw & Excel 

Reading: Organic Chemistry by Marc Loudon, 6th ed., pp. 49-59 (2.3).  

There is no prelab, quiz, or formal lab report for today’s experiment. Instead, you will work through an 
in-class exercise on modeling molecular conformations, which is due before you leave. Be sure to bring 
your modeling kit to lab if you have one. If not, some kits are available for checkout from the organic 
stockroom, or you can share with other students. 

You will also be introduced to two programs that will be used to write your lab reports: ChemDraw and 
Excel. You can save some time by installing them on your computer before the lab. To do this, go to 
www.orgchemboulder.com/Labs/Software and follow the instructions for acquiring and installing these 
programs. During this experiment, you will work through some exercises for ChemDraw and Excel; these 
are due one week from today (or two lab periods from today, during the summer). Bring your laptop to 
lab if you have one. If not, you can share with another student for now, and use the computers in the 
organic helproom or in several computer labs on campus. You can find these computer labs by following 
the instructions at www.orgchemboulder.com/Labs/Software.  

 

Modeling Conformations of Alkanes 

Organic chemists study the chemistry of carbon compounds. The simplest of these are saturated 

hydrocarbons. These molecules are composed of only carbon and hydrogen, and contain no π-bonds. 
More complicated molecules are often comprised of fragments of these compounds. In this part of the 
lab, you will use molecular models to study the structure of some simple hydrocarbons starting with 
methane and working your way up to butane. In order to do this properly, you need to understand the 
fundamentals of structure and bonding in organic compounds. While you have covered structure and 
bonding in General Chemistry, you may be rusty on these concepts.  The more important concepts in this 
experiment are highlighted in bold, and for some of these, the relevant section of Loudon (6th ed.) is 
indicated for further reading.  

Methane, hybridization, and bold and dashed lines 

Methane is the simplest hydrocarbon. It is composed of one carbon bonded to four hydrogens (Figure 
3.1). In reality, methane adopts a three-dimensional geometry in which the hydrogens do not all lie in the 
same plane, and instead point towards the corners of a tetrahedron. We refer to this as a tetrahedral 
geometry (see pg. 15 in Loudon).  Furthermore, the carbon is sp3 hybridized, with all the H-C-H bond 
angles equal to 109.5°. Hybrid orbitals are orbitals that are made up of the combination of atomic orbitals. 
Thus, sp3 hybrid orbitals are created from linear combinations of the s-orbital with the three p-orbitals. 
They look somewhat like p-orbitals, but they are lopsided with one lobe being larger than the other (see 
pg. 37 in Loudon). 

   

Figure 3.1: Methane drawn in various orientations 
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Because the substituents bonded to sp3 hybridized carbons do not all lie in the same plane, we draw these 
compounds in a specific way to indicate which ones are in the plane of the paper and which are not. We 
use bold or dashed lines or wedges for this. A bold line or wedge indicates that a group is projecting 
out of the plane of the page, and dashed line or wedge indicates that a group is projecting backwards, 
behind the plane of the page. Note: All carbons with four ligands adopt this three-dimensional shape, and 
it is never correct to draw all the atoms in the same plane for such a carbon. 

Practice Exercise 1: Make a model of methane and orient the model with respect to the paper 
such that you can visualize the orientations depicted in the figure below. 

Ethane, Newman projections, and a preference for staggered conformation 

The next higher hydrocarbon is ethane (see pg. 49 in Loudon) which contains two CH3 groups connected 
by a carbon-carbon single bond (Figure 3.2). The C-C bond can undergo rotation, thereby causing the 
two CH3 groups to rotate relative to each other. It turns out that the energy of the molecule changes as 
these groups rotate, but before we can describe this, we need a good way to visualize the orientation of 
the groups relative to each other. 

 

Figure 3.2: Newman projections of ethane and two different orientations of butane 

A very useful and common way to visualize organic molecules is to draw them in what is known as a 
Newman projection. In a Newman projection, we look directly down a C-C bond and draw the 
orientation of the ligands as they appear relative to each other. We represent the two carbons with a circle, 
and draw the bonds of the carbon in front originating from the center of the circle, and the bonds of the 
carbon in the back obscured by the circle. This depiction is called a Newman projection for its originator 
Melvin Newman at Ohio State University. It represents how the molecule would look if it were projected 
onto a plane sighting down the C-C bond. In Figure 3.2, we have drawn Newman projections for ethane 
and for butane in two different orientations. Note that we have to specify which C-C bond we are 
representing in the Newman projection, and that the direction of the ligands bonded to each carbon is 
described by Newman projection; in other words, if a group is pointing up in a structure, it will also point 
up in the Newman projection. 

Practice Exercise 2: Make a model of these molecules and convince yourself that the 3-
dimensional structure and the Newman projections are the same. 

Using Newman projections, we can examine the consequences of rotation of the methyl groups of ethane. 
As mentioned above, at room temperature, ethane can undergo rotation about the C-C bond. This rotation 
produces a different conformer, as shown in Figure 3.3. Note that conformers are NOT isomers. Isomers 
are compounds that have the same molecular formula, but different structures, and are, in principle, 
separable at room temperature. Since these structures undergo interconversion by rotation, they cannot 
be isolated or separated. Basically, when we have ethane sitting in a bottle at room temperature, the methyl 
groups are spinning relative to each other, and we can’t stop this from happening or separate the different 
conformations.  

As bonds rotate, molecules adopt different conformations, and the energy of the molecules goes up and 
down as shown in Figure 3.3. The lowest energy conformation is the staggered conformation. Staggered 
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conformations are those in which the bonds of the front carbon are in between the bonds of the rear 
carbon in the Newman projection. As we rotate one of the methyl groups (in the figure below, it is the 
methyl group in front that is rotated), the energy of the molecule increases and reaches a maximum when 
the molecule is in the eclipsed conformation. Eclipsed conformations are those in which, in the Newman 
projection, the bonds of the front carbon are lined up with the bonds of the rear carbon. The difference 
in energy between the staggered and eclipsed conformations is 2.9 kcal/mol. In general, staggered 
conformations are lower in energy than eclipsed conformations, not just for ethane, but for other 
molecules as well. 

 

Figure 3.3: Energy diagram for the rotation of ethane 

So why is the eclipsed conformation higher in energy?  As the carbon-carbon bond rotates, the atoms 
attached to each must rotate past one another.  Keep in mind that these atoms take up a certain amount 
of space, and that when the bonds are all lined up, the hydrogens are as close as they can be to each other.  
This creates strain (or increased energy) in the molecule, as a physical collision becomes possible, and the 
repulsion of electrons on the eclipsing substituents is realized.  Both of these effects are minimized in the 
staggered conformation.  

In Figure 3.4, we see that in the eclipsed conformation there are three sets of eclipsed hydrogen atoms.  
Since the increase in energy is 2.9 kcal/mol, we can conclude that each eclipsed H–H interaction is worth 
slightly less than 1.0 kcal/mol. 

 

Figure 3.4: Origin of increased energy in eclipsed ethane 

Propane and CH3-H interactions 

The next higher hydrocarbon is propane. The Newman projection of propane is shown in Figure 3.5. As 
is the case with ethane, the staggered conformation is more stable than the eclipsed, and the CH3 groups 
are capable of undergoing rotation. In ethane, the barrier to this rotation (i.e., the difference in energy 
between the staggered and eclipsed conformations) is 2.9 kcal/mol, however, in a molecule of propane, 
this barrier is 3.3 kcal/mol. This increase in energy is due to the greater steric interaction between a methyl 
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group and a hydrogen atom.  In ethane, the eclipsed conformation contains three H–H eclipsing 
interactions, however, the eclipsed conformation of propane has two H–H eclipsing interactions and one 
H–CH3 eclipsing interaction. The 0.3 kcal/mol increase in energy is due to the greater size of the methyl 
group, which repels the passing H to a greater extent. Thus, with molecular interactions, size matters; the 
larger the groups, the more severe the interaction. We already determined that each H–H interaction is 
worth about 1.0 kcal/mol, so we can determine that each H–CH3 interaction contributes approximately 
1.3 kcal/mol in increased energy. 

 

Figure 3.5: Newman projections and the energy diagram for one of the C-C bonds of propane 

Butane and gauche, anti, and syn conformations 

The trends described above continue with butane (see pg. 51 in Loudon), but with a twist. Just as in the 
case of ethane and propane, butane prefers to exist with staggered C-C bonds, but it is different from 
ethane and propane in that the central C-C bond has two staggered conformations, the anti and gauche 
conformations. This is illustrated in the Newman projections shown in Figure 3.6, in which we are sighting 
down this bond. If we label the carbons C1, C2, C3, and C4, then we are looking down the C2-C3 bond. 
In this view, we can see that the orientation of the CH3 groups (C1 and C4) relative to each other changes 
as we rotate about that bond. The conformation where the two groups are on opposite sides is called anti-
butane. Anti conformations are ones wherein the dihedral angle between two groups is 180°. (A dihedral 
angle is defined as the angle formed by the intersection of two planes. In this case the two planes are the 
C1-C2-C3 plane, and the C2-C3-C4 plane.) This is a staggered conformation, and it is the lowest energy 
conformation of the molecule. However, if we rotate the CH3 group in front, we can form another 
staggered conformation where the CH3 groups have a dihedral angle of 60° between them. This 
conformation is called gauche-butane. Again, it is important to emphasize that this is also a staggered 
conformation, but not the lowest energy conformation of the molecule. In this case, the two methyl 
groups bump into each other, and raise the energy of this conformation by 0.9 kcal/mol. 

 

Figure 3.6: Newman projections of the anti and gauche conformations of butane 

The process of rotating from anti-butane to gauche-butane requires that the molecule adopt an eclipsed 
conformation (at 120° and 240° in Figure 3.7). These conformers contain one eclipsed H–H interaction, 
and two eclipsed H–CH3 interactions. If we were to approximate how much higher in energy this 
conformation is relative to the lowest energy conformation (i.e., anti-butane), we would arrive at a value 
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of 3.6 kcal/mol (1.3 kcal for each of the two CH3–H interactions, and 1.0 for the H–H interaction). The 
observed value is very close to this estimate. 

If we continue to rotate the CH3 group, we would arrive at a structure where the two methyl groups have 
a dihedral angle of 0° and are eclipsed to each other (at 0° and 360° in Figure 3.7). This conformation is 
called syn-butane, and it is the highest energy conformation in this energy profile. The energy of this 
conformation is 5.3 kcal/mol. In this conformation, there are two H–H interactions and one CH3–CH3 
interaction. We know that the H–H interactions are worth about 1.0 kcal/mol each, which means that the 
CH3–CH3 interaction is worth 3.3 kcal/mol. It’s the most severe interaction we’ve seen so far because it 
involves the two largest groups. 

 

Figure 3.7: Energy diagram for the rotation of butane 

Practice Exercise 3: Make a model of butane and sight down the central C-C bond in each of the 
conformations drawn in this scheme. 

From the information above, we can list the energy cost of each type of interaction. There is no energy 
cost for any type of gauche interaction involving H as a group – it’s just too small to be affected by other 
groups gauche to it.  

Interaction Cost 

H-H eclipse ~1 kcal/mol 

CH3-H eclipse 1.3 kcal/mol 

CH3-CH3 eclipse 3.3 kcal/mol 

CH3-CH3 gauche 0.9 kcal/mol 

 

The energies of the eclipsed conformations are all low enough that this molecule is rapidly spinning about 
the central C-C bond at room temperature. However, because the eclipsed conformations are not energy 
minima, the molecule only exists in these conformations as it is passing from one staggered conformation 
to another. In other words, if we have a flask which contains butane at room temperature, about 80% of 
the molecules exist in the anti conformation, and about 20% in the gauche conformation; the molecules 
are going back and forth between these two conformations. In order to do this, they must pass through 
an eclipsed conformation, but they don’t stop at these conformations - they just go through them on their 
way to the other staggered conformation. (For this reason, it is described as a transition state.) 

Also, as before, because these molecules cannot be separated at room temperature, these are conformers, 
not isomers. 
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Name__________________________________ 

Modeling Conformations 

1. In the box below each molecule, draw Newman projections for the structures A, B, and C shown 
from the perspective indicated. For each Newman projection that you’ve drawn, indicate if there 
are any eclipsed bonds or gauche butane interactions. (6 pts) 

 
 

2. Structure A can exist in a lower energy conformation by undergoing a bond rotation; draw the 
Newman projection of this conformation. (4 pts) 

 

 

 

 

 

 

 

 

3. You might have noticed that structures A, B and C are really just different conformations of the 
same molecule. In the graph area on the back of this page, draw an energy diagram for the rotation 
of this molecule, starting with the conformation shown in structure C (this will be 0° on your 
graph). For each eclipsed or staggered conformation, draw the Newman projection and calculate 
the expected energy of the conformer. Rotate the front carbon clockwise while keeping the back 
carbon stationary. It might be helpful to use Figure 3.7 as a guide. (10 pts) 
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Using ChemDraw to Depict Organic Molecules 

ChemDraw is the chemical structure drawing program most frequently used by organic chemists. Most of 
the chemical structures that you see in textbooks, journal articles, and online were created with it. The use 
of ChemDraw (or another chemical structure drawing program of your choice) is also required in all of 
the lab reports you will turn in for this course. Besides drawing structures, ChemDraw is also useful for 
calculating the formula and molecular weight of a compound. 

CU Boulder has purchased a site license for ChemDraw, so you can download it for free and install it on 
your own computer – instructions are given at www.orgchemboulder.com/Labs/Software. ChemDraw is 
also installed on all the computers in the organic chemistry labs and helproom; feel free to use it at any 
time that the labs are open.  

The following exercise is designed to introduce you to the basics of ChemDraw. The required parts are 
marked with “Exercise.” For these parts, you should paste the resulting ChemDraw structure into a Word 
document which you will turn in to your TA.  

Open ChemDraw and choose settings: Once you have installed ChemDraw on your computer, double 
click on the ChemDraw shortcut or go to the Start menu. Once the program is running, you will see a 
large drawing area, a tool palette, and the menu bar. Change the settings to the ACS (American Chemical 
Society) template: Under the File menu, select “Apply Document Settings from” and choose “ACS 
Document 1996”. This makes your document match the standards for the American Chemical Society. 
You should use these settings for any ChemDraw images you use create in your prelabs and lab reports. 
 

 

Drawing using the bond tool: Click once on the bond tool, third down on the left in the tool palette. 
When you click on it, its square will lighten to show it is selected and the pointer will become a crosshair. 
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With the bond tool active, click and hold the mouse in the drawing area. Drag the mouse until the bond 
is oriented how you want it. (You will only be able to draw a bond of a preset length; if you want to draw 
a line of any length, go to the object menu and uncheck “fixed lengths”.) 

Once you have one bond drawn, place the cursor on one end of that bond. A blue square will appear: this 
means that you can click and drag again to build another bond onto your molecule. 

To draw a double bond, with the bond tool selected, click on a single bond once to create a double bond. 
Try this a few times. You can also right-click a bond and change it to a double or triple bond, or use the 
double bond tool in the toolbar (right below the single bond tool). 

Fixing mistakes: Made a mistake? It’s okay! Find the eraser—shaped like an eraser and third down on 
the right in the tool palette. Highlight it, then click on the mistake. 

 

Another way to get rid of things that you do not want is to select it and hit the backspace or delete key. 
To do this, click on either of the select tools in the top row of the palette and double click on a structure 
or draw a box or lasso around it. When selected, a structure will have a light blue box drawn around it. 
Anything selected can be moved, copied, or deleted, among other options. 

 

You can undo an action by typing control-Z, or by going to the Edit menu and selecting Undo. 

Copying into Word: Once you start drawing structures, you can paste them into Word documents. (If 
you don’t have Word on your computer, you can download a copy for free. Instructions are given at 
www.orgchemboulder.com/Labs/Software). 

To copy your ChemDraw structure or group of structures into Word, select all of the objects and 
structures you want to copy by drawing a box around them or lassoing them and copying with the copy 
command under the edit pull down menu. Then go to Word and paste them where you want them. Once 
a ChemDraw file is embedded in Word, you can always double-click it to edit it. 

Depending on your operating system and version of Word, you might encounter compatibility issues with 
inserting ChemDraw objects directly into Word. In these cases, the best workaround is to save your 
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ChemDraw file as an image file (the .gif, .jpg, .png, .tif, and .emf file formats should all be compatible with 
Word). Once this image file is inserted into Word you will not be able to make any more changes, so be 
sure to save your ChemDraw file as a .cdx file, so you can return to it later to work on it if needed. 

A word of warning: not all of the computer labs on campus have ChemDraw installed. If you’re using a 
computer without ChemDraw and you try to open a document that has structures copied directly into it, 
the ChemDraw structures will just appear as grey rectangles. Therefore, if you’re planning on printing on 
campus, then you should either save the ChemDraw structures as images before putting them into Word 
or make sure you know where to find a ChemDraw-enabled computer lab (instructions are given at 
www.orgchemboulder.com/Labs/Software).  

 
Exercise 1: Draw the molecule shown here. It doesn’t have to look tidy. Paste the structure into a 
new Word Document, and label this structure as Exercise 1. (You should label all the following 
exercise with their numbers too.) 

 

 

Drawing chains of carbons: If you need to draw a long chain of carbons, click on the carbon chain tool 
(see below) and click and drag the mouse across the screen. The end of the chain will have a number after 
it, indicating how many carbons you have drawn so far, but this number will disappear once you release 
the cursor. 

 

If you hold down the mouse on the chain tool, you also have the option of drawing a freeform chain 
rather than a linear chain.  

Adding heteroatoms: Click on the label tool (it looks like an “A”, second column in the tool palette, 4th 
down). The pointer turns to a text cursor until you are over any bonding site, then it changes to an “A” 
in a box. 

 

Click on any bonding site and type in an appropriate atom label. You can also use the text tool to click 
anywhere in the drawing area and create text. 
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If you are using one of the selection tools, you can mouse over an atom and type the letter of a heteroatom. 
(Since it’s only a single letter, there is some overlap in elements – for instance, typing a lowercase “b” will 
create a bromine atom, while typing an uppercase “B” will create a boron atom.) Note that ChemDraw 
will automatically add the appropriate amount of Hs to the new heteroatom. 
Exercise 2: Draw the following molecule and copy it into your document.  

 

Drawing Rings: There are several ring tools in the palette. For organic chemistry, you will probably use 
the aromatic ring and the cyclohexane ring most often. To change the orientation of the ring, you can do 
one of two things: either draw it, then select it, right-click it and choose Rotate from the menu; or click 
and drag while you are drawing it, then release the mouse button once you reach the appropriate 
orientation. 

   
Exercise 3: Draw the structures shown above and copy them into your document. 

Drawing reactions: Use the arrow tool to draw an arrow of any length. The first time you use this tool, 
you might need to change the type of arrow. Do this by clicking and holding down the mouse, and then 
move to highlight the arrow of your choice. 
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Often a reaction will involve changing a molecule just a little. Thus, you can draw it once, then copy and 
paste it to the right of the first structure, then modify the second structure.  
Exercise 4:  Draw the complex molecule on the left, select it, copy it, and paste it to the right - 
move it around if necessary. Modify it to the product. Draw an arrow between the two. Copy the 
final reaction into your word document.  

 

 

Tidying up your structures: If your structures look messy, you can use the Clean Up Structure tool to 
give them uniform bond angles and make them look professional. To do this, highlight a structure, then 
go to the Structure menu and select Clean Up Structure (or type Ctrl+Shift+K by holding down the shift, 
control, and K keys simultaneously). Sometimes you might need to do this multiple times, as the structure 
may only get slightly neater after each iteration. In some cases, if you keep cleaning up, ChemDraw will 
try to draw the molecule in a different orientation to see if that’s what you want. Remember, you can 
always go back a step by selecting “undo.” 

 

You can also align and distribute your drawn molecules to make them look better on the page. Select the 
structures that you want to work with, then go to the “Object” menu, go down to “Align”, then choose 
to align left edges, right edges, L/R (left/right) centers, top edges, bottom edges, or T/B (top/bottom) 
centers. The “Distribute” function is also in the Object menu; this allows you to put equal spacing between 
molecules in a row.  

 
Exercise 5:  Copy the molecules you drew for Exercises 1, 2, and 3. Clean each of them up and 
then put them into a horizontal row together. Align their T/B centers and distribute them 
horizontally. Copy the aligned structures into your document. 

Grouping objects: You can also group objects together. Once they are grouped, objects will stay in the 
same position relative to each other. To do this, right-click and select Group, or type Ctrl+G. You can 
ungroup them later if you need to. 

CleanupCleanup Cleanup Cleanup
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Exercise 6: Draw the following reaction. 

 

Align the L/R centers of the text and the arrow; then group them together. Then select all of the 
objects for this reaction, align their T/B centers and distribute them horizontally. Copy the 
reaction into your document. Notice how grouping allows the text and the arrow to remain 
together, instead of getting spread out and separated. 

There’s a shortcut that will allow you to do these cleanup steps automatically, if you have a starting 
material, a product, and some reagents written on an arrow. Select all these components, then go to the 
Structure menu and select Clean Up Reaction (or type Ctrl+Shift+X).  

Exercise 7: Draw the same reaction from the previous exercise, but this time use Clean Up 
Reaction to tidy it up.  

Showing mechanisms: For all of the reactions you perform in this class, you will have to show 
mechanisms – the movement of electrons that occurs as bonds are formed and broken. These are shown 
with curved arrows. You can draw these by holding down your mouse on the arrow in the toolbar – a 
menu should pop out to the right.  

 

There are various curved arrows with various degrees of curvature. A full-headed arrow like → indicates 

two electrons are moving as a pair – the most common method. A half-headed arrow like ⇀ indicates a 
single electron is moving alone. Often you will also have to show charges – these can be selected from 
the fourth menu down from the arrows menu (it will often look like a pair of electrons by default).  

Exercise 8: Draw the following mechanism. 

  

Using templates: For some reactions in this course, the starting materials or products are difficult to 
draw due to complicated three-dimensional structures. In this case, there are several preexisting templates 
that will make your job a lot easier. To do this, go to the tool that looks like a rubber stamp – a menu 
should pop out to the right.  
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Exercise 9: Draw the following reaction, using an appropriate template in the “Bicyclics” menu. 

 

Analysis window: You can also use ChemDraw to analyze certain properties of the molecule you have 
drawn, including molecular weight and formula.  
Exercise 10:  Draw the following molecule and select it. 

 

Go to the “View” menu and choose “Show Analysis Window.” Click the Paste button that appears 
in this new window – the properties should appear under your structure. Copy the structure and 
its list of properties into your document. 
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Using Excel for Data Analysis and Calculations 

Excel is a Microsoft program that allows you to manipulate spreadsheets. Becoming familiar now with 
Excel (or any other adequate spreadsheet program of your choice) will allow you to save time on postlab 
calculations, as well as being extremely useful outside of this course. This tutorial is focused exclusively 
on Excel 2016. However, if you prefer to work through this exercise in a different spreadsheet program, 
you may do so, as long as you make a note at the top of the document to tell your TA which program you 
are using. Instructions for accessing Excel and several other spreadsheet programs are given at 
www.orgchemboulder.com/Labs/Software.  

This exercise is designed to introduce you to using Excel for data analysis and calculations. The required 
parts are marked with “Exercise.” For these parts, you should print the final version of the spreadsheet 
and turn it in to your TA. 

Open Excel and create a new blank workbook: Once you have access to Excel on your computer or 
a campus computer, open up the Excel program. Create a blank workbook - this may happen automatically 
in older versions of Excel. A workbook is a file type that contains one or more spreadsheets. Each 
spreadsheet is a grid of cells, and each cell can contain different types of data – for example numbers, text, 
or formulas. Cells are named with a column (given a letter heading) and a row (given a number heading). 
In the image below, a workbook named “Excel book.xslx” is open, and it contains two spreadsheets – 
“Excel tutorial” and “Other sheet”. A few cells in the “Excel tutorial” sheet are labeled with their names, 
such as B2 and A4. 
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Exercise 1: Open Excel and copy this data into a new spreadsheet.  

Time (min) Volume (mL) 
0 10.1 
1 11.9 
2 14.5 
3 15.5 
4 18.9 
5 20.9 
6 22.7 
7 23.9 
8 26.0 
9 28.2 
10 31.0 

If you need to make a column wider, you can do it by double-clicking the line between column headers. 
If column A is too narrow to show the entire text of “Time (min)”, double-clicking the line between 
columns “A” and “B” will fix this.  

Graphing data: A common use for Excel is for graphing data. There are many types of graph available, 
but the only type that lets you treat the x-axis (time, in this case) as an independent variable is the scatter 
chart. To create a chart of this data, highlight all the cells that have numbers in them, go to “Insert” in the 
menu, and select scatter chart. Choose the first option that looks like disconnected data points, as shown 
below. This should create a new scatter chart of your data and place it into the spreadsheet with your data. 
By default, Excel will turn the first row or column of data into the x-axis (highlighted in purple), and the 
second row or column into the y-axis (highlighted in blue).  
 

 
 

Exercise 2: Create a scatter chart of the data you input for Exercise 1.  
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Once it’s created, you can drag the chart out of the way so it doesn’t cover your data. You should always 
label the chart itself and each axis. Click inside the chart so it’s selected. If you don’t already have labels 
visible, go to “Chart Elements” (a green plus sign that appears to the right of the chart when you click the 
chart) and turn on the “Chart Title” and “Axis Titles” checkboxes. You can also do this by going to the 
“Chart Tool – Design” menu in the upper right, and selecting “Add Chart Element”. Double-click in each 
of these text areas and rename them appropriately. The horizontal (x) axis should be labeled to match the 
first column of data (time), and the vertical (y) axis should be labeled to match the second column 
(volume). The chart title should normally be something like “Y-axis vs. X-axis” – in this case, “Volume 
vs. Time”.  

Next, you should add a trend line to your data. The exact shape of the trend line will depend on what you 
are graphing, but in this case we will use a linear trend line. Go to the green plus again (or “Add Chart 
Element”) and add a linear trend line. Once it’s added, you should be able to double-click it if you want 
to change any of its properties.  

 

Exercise 3: Label your chart and its axes, and add a linear trendline to your data. Drag the graph 
down below your data so it’s out of the way when you do the next part.  
 
Using Excel for Calculations: The most compelling reason to use a spreadsheet program is that it will 
automatically perform a large number of calculations for you, saving you from having to do them with a 
calculator. Any cell can hold a calculation based on references to other cells. To start entering an equation, 
type an equals sign first. You can type directly into the cell, or you can use the white bar above the main 
spreadsheet area (the formula bar – visible in the upper right corner of this image). For this data, we might 
want to calculate how much the volume has changed since the initial volume, so we could set up a new 
column where the volume cell has 10.1 mL (the initial volume) subtracted from it. In the first cell, C2, this 
formula would be: 
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If you want to put an equivalent formula into each cell, finish typing the equation and hit enter. Then 
select the cell by clicking in it. It should have a box around it, with a small square in the bottom-right 
corner. If you grab this box and drag downwards, you can fill all the cells in this column with a similar 
formula, updated to reflect where it is. For instance, cell C4 will say “=B4-10.1” instead of “=B2-10.1”. 
You can check this by clicking any of the cells that has a formula in it, and then looking at the formula 
bar.  

 
 
However, typing a number directly into a formula is not the best way to do things. If you end up realizing 
there was a mistake, you might have to go through and replace 10.1 with the corrected number in every 
single cell. Instead, you should use a formula that subtracts the initial volume from the volume at each 
measurement. To do this, you’ll need to use an absolute reference, which means putting a dollar sign 
before the column and row of the cell you’re referring to. So an absolute reference to cell B2 would look 
like $B$2. Let’s replace all the references to 10.1 with a reference to $B$2 instead.  

 
Again, once you’ve put this formula into one cell, you can grab the square and drag it down to fill all the 
cells with an equivalent formula. Note that the reference to B2 gets changed in the other cells, but the 
reference to $B$2 stays the same.  
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Exercise 4: Add a column to calculate volume at any time minus the volume at time zero, as 
shown above.  
 
Now if you type a different number into cell B2, all the cells based on this will be automatically updated. 
Try this now to see what happens, then undo the change by hitting the “undo” backwards arrow in the 
very top of the Excel window.  

 
 
You can also use absolute references to refer to constants. For instance, if the volume that you’re 
measuring is of a liquid with a known density, you can calculate change in mass by multiplying density by 
the change in volume. In this case, it’s done by putting the density into cell F2 and then putting an equation 
that multiplies each cell by $F$2.  

 
 
Exercise 5: Add a cell nearby in the spreadsheet that contains a value of 1.39 (labeled as density), 
and then use this to calculate change in mass for each measurement as shown above. 
 
Again, note that if you type a different value into the Density cell, all of the cells based on that value will 
automatically update. Try this now, and then undo your change. 
There are a wide range of other formulas that are available in Excel. If you click the “Formulas” tab at the 
top of the page, you can view all of the options. Hovering the cursor over any of these will give you an 
explanation of what it does and how to use it. We will not use these functions in this tutorial, but many 
of them may prove useful in future classes. 
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Formatting cells: If you want to control how the contents of a cell look, you can right-click in a cell (or 
range of cells, if you have a range selected already) and select “Format Cells”. You can change the 
background color, font, border, and alignment of a cell, but you can also control how a number is 
displayed. For instance, if you go to the Number tab, you can choose how many decimal places are shown. 
 
Exercise 6: Change all of the cells in the Mass column so they have two decimal places.  
 
Ultimately your spreadsheet should look similar to this. Print your spreadsheet and hand it in.  
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